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Create Charts



Charts
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Charts are graphical representations of the numeric values and relationships in a dataset. 
Charts help worksheet viewers to quickly and easily interpret the data in a worksheet. Excel 
charts update automatically when you update the data feeding them. And, some chart 
types contain animation functionality that helps worksheet viewers more easily discern 
overall patterns in the changing data as you update it.
In this figure, while you can tell from the 
values in the Total Sales (in millions) 
column what the sales are for each market, 
the pie chart to the right of the data is 
much easier to interpret. With just a 
glance, you can tell that sales in the West 
region are greater than the sales in the 
other three regions, and that they account 
for more than a third of all sales. Getting 
this information from the raw data would 
require a bit of analysis and some 
calculating.



Chart Basics
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Excel 2021 offers many chart types, but most follow the same conventions. Charts typically use two axes:
• X axis (horizontal): Represents categories, such as time periods or departments.
• Y axis (vertical): Represents values, such as sales totals or quantities.
The chart objects (bars, columns, lines, etc.) represent data series, like regions or sales reps. Excel builds 
charts directly from worksheet data:
• Column labels → categories (X axis)
• Row labels → data series
• Cell values → plotted values (Y axis)



Chart Insertion Methods
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Before creating a chart, it’s best to manually select the dataset, including both row and column labels, to 
ensure Excel interprets the data correctly.
• Column labels → categories (X axis)
• Row labels → data series
• Cell values → plotted values (Y axis)
Once the dataset is selected, you can insert a chart using four main methods:
• Quick Analysis tools
• Ribbon commands (Insert tab)
• Insert Chart dialog box
• Default chart type
If you frequently use the same chart type, you can set it as the default chart type. Then use these shortcuts:
• Alt+F1 → Inserts the default chart on the same worksheet.
• F11 → Inserts the default chart on a new worksheet.

 You set the default chart type for Excel by right-clicking the desired chart subtype from the 
Insert Chart dialog box and selecting Set as Default Chart. This is an application-level setting, so 
what you set here will be the default chart type for any workbook file until you change the 
default chart type.



The Insert Chart Dialog Box
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The dialog box has two tabs:
•Recommended Charts tab → Displays chart subtypes Excel suggests based on your 
selected dataset. You can preview how each recommendation would look before inserting.

•All Charts tab → Lets you browse all available chart types and subtypes. Each option 
includes a live preview, often with formatting variations, so you can choose the exact style 
that fits your data.

 In short: Recommended Charts helps you quickly pick from Excel’s suggestions, while All 
Charts gives you full control to explore every chart type and formatting variation.



Chart Types
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Excel 2021 includes 17 different chart types, each 
of which is ideal for displaying a particular type of 
data or set of relationships. Each type of chart 
contains a variety of specific subtypes that you can 
use to tailor the presentation of your data. You can 
access the chart types and subtypes in the Insert 
Chart dialog box, which you can use to insert charts 
into your worksheets. You can access the Insert 
Chart dialog box by selecting the dialog box 
launcher on the Charts group on the Insert tab, or 
by selecting the More option from any of the chart 
type drop-down menus in the Charts group on the 
Insert tab.



Chart Type Is Best Used to Display
Column Relationships among values in a number of categories or changes in values over time.
Line Trends in data over a period of time at consistent intervals (for example, quarterly or annually).

Pie The relative size of values, compared to the whole and to other parts of the whole. This is the 
best chart to use when you are charting only a single column or row of data.

Bar Relationships among values in a number of categories.

Area Relationships among values in a number of categories over time with visual emphasis on the 
magnitude of each data category.

X Y (Scatter)
The relationship between two categories of measured data, as opposed to one category of 
measured data across evenly spaced periods of time. Use this chart type to determine if there is a 
trend in the relationship between two sets of variables.

Map Data comparisons across geographic regions.

Stock The change in stock prices over time or other similar fluctuating sets of values, such as daily or 
annual temperatures.

Surface
Three-dimensional representations of data. Typically, you would use a surface chart when 
working with three sets of data. An example of this would be charting the relative change in 
density of several materials, at a variety of temperatures, over a period of time.

Treemap A hierarchical chart; it shows a hierarchical view of your data and how the parts of the hierarchy 
compare in size to each other.

Chart Types

7



Chart Type Is Best Used to Display

Radar
The aggregate relational sizes of multiple data categories in terms of multiple criteria. For example, 
you could use a radar chart to track the popularity of a particular item in multiple countries for each 
year in a decade.

Sunburst Visual comparisons of relative sizes, similar to Treemap. The difference with Sunburst is showing the 
links between groups and sub-groups. 

Histogram A column chart that shows frequency data. The difference is that each column represents a range of 
values (called a bin) instead of a single value.

Box & 
Whisker

Statistical information about a set of data; the distribution of data into quartiles, highlighting the 
mean and outliers. 

Waterfall A running total as values are added or subtracted. It's useful for understanding how an initial value 
(for example, net income) is affected by a series of positive and negative values.

Funnel Values across a process with multiple stages. Typically, the values decrease as the data moves 
through the process (for example, prospects in a sales pipeline).

Combo

Relationships among values of widely differing ranges of data. For example, if you want to chart unit 
sales measured in thousands of units on the same chart as sales in billions of dollars, you could use 
a combo chart so that both sets of values, which are on vastly different scales, can be displayed 
simultaneously. Combo charts are also referred to as dual-axis charts.

Chart Types
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Recommended Charts
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Excel 2021 includes a handy feature 
to assist you with selecting the most 
appropriate chart subtype for the 
selected data: recommended charts. 

Based on the dataset you select, Excel 
2021 uses an algorithm to determine 
which of the chart subtypes would 
best suit your needs. You have access 
to recommended charts in two 
places: from the Quick Analysis tools 
and from the Recommended Charts 
tab in the Insert Chart dialog box.



Activity 21. Creating Charts
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Modify and Format Charts



Modification vs. Formatting
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Modifying a Chart
• Focus: Adjusting how the data is displayed.
• Examples:

• Moving chart elements (titles, legends, labels).
• Adding/removing chart elements.
• Turning specific data series on/off.
• Changing the chart type (e.g., column → line).

• Purpose: To improve how the audience interprets the information.
• Think of it as: Changing the structure of the chart to clarify the story the data tells.
Formatting a Chart
• Focus: Adjusting the visual style and appearance.
• Examples:

• Changing colors, fonts, or themes.
• Resizing the chart.
• Applying branding guidelines.

• Purpose: To align with design standards or convey a particular mood.
• Think of it as: Styling the chart so it looks polished and consistent.



Modification vs. Formatting
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Chart Elements
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Chart elements are the individual objects that can appear on charts and that convey some 
level of information to a viewer about the chart's data. While all Excel charts contain at 
least one chart element by default, the various chart types display different chart 
elements. Each chart element serves a different role in visually communicating information 
about data and trends.



Guidelines for Modifying Chart Elements

15

Formatting charts has relatively little impact on an audience's ability to interpret your data. 
Modifying chart elements, on the other hand, can have a significant impact. As a general rule, it's 
best to include only those chart elements that are absolutely necessary for conveying meaning. 
Cluttered charts can muddy your main point and make your charts confusing to view, and avoiding 
confusion is exactly why you created them in the first place.
However, some chart elements do actually help add meaning. Until you gain an intuitive sense of 
what chart elements to include for various purposes, you may want to consider adding chart 
elements that you feel will help your target audience interpret your data, analyzing your chart, and 
then removing anything that doesn't directly contribute to the message you intend to deliver. 
When analyzing your charts, ask yourself questions such as:
• If I remove the gridlines, will the chart still convey meaning?
• Do I need a legend? Can I remove the legend and use data labels instead?
• How much precision do I need for axis labels?
• Do the axes really need titles?
• Will using a three-dimensional layout enhance visual appeal or distort proportions?
• Does including the data table aid understanding?
• Do I really need major and minor tick marks on the axes?



The Chart Contextual Tabs
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You can access many of the commands you will use to modify and format your charts on 
the two chart contextual tabs, which appear whenever you select a chart or a chart 
element and disappear when you select a worksheet element outside the chart. Each of 
these two tabs contain task-related groups and commands for working with your charts. 
Let's take a look at the various command groups on both of these tabs.



Chart Design Tab 
Command Group Contains Commands For

Chart Layouts Adding or removing individual chart elements, and quickly configuring the 
display of all chart elements according to predefined configurations.

Chart Styles Quickly formatting a chart by using predefined sets of formatting options.

Data

Changing the chart's dataset range and switching the row and column 
data. Keep in mind that this does not switch the data that is displayed on 
the X axis with the data that is displayed on the Y axis. This switches the 
categories with the data series.

Type Changing the chart type.

Location Moving charts to different worksheets within a workbook.

The Chart Contextual Tabs
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Format Tab Command 
Group Contains Commands For

Current Selection Selecting particular chart elements and accessing the Format task pane.

Insert Shapes Inserting or changing shapes on worksheets.
Shape Styles Configuring formatting options for chart elements.
WordArt Styles Configuring formatting options for chart text.

Accessibility Configuring alternative text for use by screen readers meant for visually 
challenged people or people suffering from vision impairment. 

Arrange Changing the front-to-back placement of chart elements and configuring 
the orientation of chart elements.

Size Changing the size of charts and chart elements.

The Chart Contextual Tabs
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The Format Task Pane
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The Format task pane in Excel 2021 is a context-sensitive 
tool that lets you fine-tune chart appearance. 
It opens when you choose Format → Format Selection 
from the chart contextual tab, and its name changes 
depending on the element selected, for example, Format 
Axis or Format Chart Title. The pane adapts to the 
chosen element, showing different tabs and commands. 
At the top level, it often separates options into text 
formatting and object formatting. Within these, lower-
level tabs group related functions, and expandable 
sections provide specific commands for adjustments such 
as fonts, fills, borders, and effects. In short, the Format 
task pane gives precise control over both text and visual 
elements, ensuring charts are polished and tailored to 
your needs.



Format Task Pane Element Description

Title Displays variations of the Format task pane's title, depending on the chart element 
that is currently selected.

Task Pane Options drop-down arrow Provides you with access to options for moving, resizing, or closing the Format task 
pane.

Options drop-down arrow

Opens a drop-down menu that enables you to select different chart elements for 
formatting purposes. This is essentially the same menu you can access by selecting 
the desired chart element from the Chart Elements drop-down list on the Format 
contextual tab. Changing the selection changes the task pane's title and the displayed 
tabs and commands.

High-level tabs

Divide the formatting commands into functional groups at the highest level. 
Essentially, these divide the formatting commands and options between object 
formatting tasks and text formatting tasks. If a chart element doesn't contain text, the 
Format task pane displays only a single option at this level of the hierarchy.

Low-level tabs Divide the formatting commands and options at a more granular level than the high-
level tabs. The low-level tabs available are dependent upon your current selection.

Command sections You can expand or collapse these task-specific sections to access or hide the specific 
commands and options you will use to format chart elements.

Commands and options Enable you to apply formatting options to the selected chart element.

The Format Task Pane

20



The Chart Tools Buttons
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Chart Tools 
Button Selecting This Button

Chart 
Elements 
button

Opens a menu that enables you to toggle on 
or off, as well as modify, various chart 
elements.

Chart Styles 
button

Opens a gallery providing you with quick 
access to various chart styles and color 
schemes.

Chart 
Filters 
button

Opens a menu that enables you to quickly 
toggle on or off the display of chart series, 
chart categories, or individual elements 
within either of these. From this menu, you 
can also toggle on or off the display of 
series labels and category labels.



The Select Data Source Dialog Box
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You will use the Select Data Source dialog box to manage Excel chart data. From here, you 
can edit the entire dataset feeding the chart or you can edit the data feeding any of the 
individual data series. You can also remove from or add back to the chart any of the 
individual data series, reorder how the data series appear on the chart, or switch the 
chart's X and Y axes. You can access the Select Data Source dialog box from the chart 
contextual tabs by selecting Chart Design → Select Data.



Chart Animations
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As previously mentioned, when you update the data associated with a chart, the chart 
itself also updates. In Excel 2021, these changes are animated to help worksheet 
developers and viewers get a clearer sense of how the changes affect the overall values 
and relationships in the chart. This functionality can also enable you to create dynamic, 
animated charts by using some of the add-ins available for Excel 2021.



Activity 22. Modifying and Formatting Charts
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Use Advanced Chart Features



Dual-Axis Charts
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A dual-axis chart is, simply, a chart that 
displays two sets of information on the 
same chart. This can be in the form of a 
dual-Y-axis chart, which displays two data 
series simultaneously, or a dual-X-axis 
chart, which displays two sets of 
categories simultaneously. By far, dual-Y-
axis charts are used more frequently than 
dual-X-axis charts. But dual-X-axis charts 
can be useful for particular types of charts, 
such as bubble charts or XY (scatter) 
charts.
The main advantage to dual-axis charts is the ability to not only display two different sets 
of data simultaneously, but also to format the different sets of data independently of each 
other. This means you can make the various data series easily visually distinguishable from 
each other and display them within the same amount of space using different scales.



Forecasting
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In addition to creating secondary axes to display various data series or categories 
simultaneously, Excel includes a chart feature that can help you forecast trends in your 
data. Forecasting is the process of using the trends that exist within past data to predict 
future outcomes. By its nature, forecasting can never be entirely accurate, as one can 
never precisely predict all possible future outcomes. As a general rule, the farther you 
forecast out into the future, the less accurate your forecasts become.



Trendlines
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In Excel, trendlines are chart elements that can graphically represent both the current 
trends that exist within your data and future forecasts of those trends. You can add 
trendlines to any of the following non-stacked, 2-D chart types: column, line, bar, area, 
stock, XY (scatter), and bubble. You can name and format trendlines to make them easier 
to view on charts or to adhere to organizational branding standards. To access the options 
for adding trendlines to your charts, select the desired chart to display the chart tools 
buttons, select the Chart Elements button, point the cursor at the Trendlines check box, 
and then select the arrow that appears to the right of it.



Trendline Type Use This to Display or Forecast Data That
Exponential Increases in rate of change at an ever-faster rate over time.

Linear
Has a proportional relationship. When you graph linear relationships, 
the resulting graph is a straight line that represents a trend that holds 
steady or that increases or decreases by a steady rate.

Logarithmic Has a rapidly increasing or decreasing rate of change that eventually 
levels out.

Polynomial Fluctuates over time.
Power Increases in rate of change at a steady rate over time.

Moving average
Fluctuates randomly over time. Use this type of trendline to smooth 
out random patterns of values to give viewers a sense of the overall 
average change in values over time.

Trendline Types
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You can use different types of trendlines to display and forecast data trends depending on 
the type of data you wish to analyze. Excel provides you with six options for adding 
trendlines to your charts.



The Format Trendline Task Pane
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You will use the Format Trendline task pane to apply formatting and 
effects to your chart trendlines and to change the type of trendlines 
in your charts. You can access the task pane by selecting the desired 
trendline; then, on the chart contextual tabs, 
select Format → Format Selection.



Activity 23. Creating a Dual-Axis Chart with a 
Trendline
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Chart Templates
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A chart template in Excel 2021 lets you save all the formatting and modifications you’ve 
applied to a chart so you can reuse them in future workbooks. This is especially useful if 
you’ve customized charts to meet organizational branding guidelines or need to create 
consistent visuals across multiple projects.
Chart templates are stored as .crtx files in the Charts subfolder of the Microsoft Templates 
folder. Once saved there, they can be accessed from the Templates tab in either the Insert 
Chart dialog box or the Change Chart Type dialog box. If you save the template outside the 
Charts folder, it won’t appear in those dialog boxes.



Activity 24.Creating a Chart Template
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